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This month our Program 
Coordinator, Rick Matteson, 
will demonstrate the key 
features of a software suite 
titled Printfolio, by BeLight 
Software.

Printfolio is a suite of 
four professional printing 
programs (Business Card 

Composer, Swift Publisher, Disc Cover 
and Mail Factory) plus image editing program 
– Image Tricks. Each one is specially tuned for 
a particular printing project, thus is an expert 
in its field. Complete integration allows you to 
exchange data between the programs. Common 
interface helps to understand and work with 
each application.

With Printfolio you will be able to:
| Prepare unique business cards, update your 
card information (if your information changes).
| Create flyers, brochures and catalogs which 
are a great source of promoting your service.
| Make beautiful-looking CD and DVD covers 
for your music collections. Mark your backup 
discs in a convenient way to have all your 
backups in order.
| Maintain a corporate look of your business 
correspondence. 
| Automate your postal correspondence if you 
have a large mailing list.

System Requirements: Mac OS X 10.3.9 or 

(Q&A continues on Page 3.)

After seeing Dave 
Marra’s presentation on 
Friday, June 8, all I can 
say is WOW! I have seen 

Dave every time he has 
presented to our group, 
but this time was the 
most exciting and infor-
mative ever. I have never 
seen so much informa-

tion packed into an hour-and-a-half. There was 
never one moment when the audience was not 
totally attentive. 

First in the lineup of new products dis-
cussed was the Apple TV. It is easy to connect, 
and enables you to view any iTunes content, 
including music, movies, TV shows, and photos 
from you iPhoto library. It can connect to your 
network via Ethernet, or wireless connectivity. 
It comes with either a 40 GB ($299) or 160 GB 
($399) hard drive. One interesting new develop-
ment: all YouTube content is being converted 
to QuickTime H.264 for maximum quality on 
Apple TV. Complete specifications can be found 
at www.apple.com/appletv/specs.html. 

Next presented, was the much-anticipated 
iPhone. The most unique feature is the real 
internet browsing that is identical to what you 
see on your computer. The wide screen view 
really helps make this feature a truly excellent 
browsing experience. Dave also emphasized the 
advanced sensors. In addition to the motion 
and light sensors, there is also a proximity sensor. 
The proximity sensor detects when you bring the 
phone to your cheek, and deactivates the touch 
screen, so that you don’t inadvertently hit an 
on screen button that may trigger an unwanted 
action. Other great features include: 
| Call merging (conference calls).
| Visual voice mail (you can choose which  
message you listen to, rather than going 
through the cue).
| Bundled Yahoo e-mail.

Dave then spoke about the new MacPro, 
available in 4-Core, and 8-Core models. The 
unbelievable power of these machines, allows 
you to run several programs at once with no (lit-
erally) loss of speed. You can perform complex 
operations using only a fraction of the CPU’s 
power. Complete specifications can be found at 

General meeting time schedule:
Meetings are held at The New York Institute of Technology,
Building 300 (Anna Rubin Hall), Old Westbury, Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m.
Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m.
followed by announcements and raffle drawings.
SIG (Special Interest Group) meetings 8:30–10:00 p.m.
Photoshop SIG: No meetings in July and August.
Multimedia SIG: No meetings in July and August.
MacBasics SIG: No meetings in July and August.

| In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at 
the Plainedge Library, (516) 735-4133, 
on Wednesday, July 18th, at 8 p.m.  
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Bill Medlow
President
ArchBill@optonline.net

| I need a scanner recommendation for a 
good quality tabloid size scanner. I have a 
Epson 836XL SCSI scanner now. My G5 and 
iMac don’t have SCSI.
Microtek has some big scanners but their 
track record in supporting the latest Mac OS 
has been poor, so I’d stick with Epson. They 
have really only one tabloid model now, the 
2400 (compared to the 800 dpi of your old 
model) dpi Expression 10000XL with USB 2.0 
and FireWire connections. It works with old 
Macs running Mac OS 9 on up to Intel based 
Macs running Mac OS 10.4. It’s about $2160 at 
PCNation.com. You may be able to find on eBay 
the older 1600 dpi Expression 1640XL which 
had USB for $700. I see that the Epson store 
has a refurbished GT-15000 which only did 600 
dpi but at least has a USB port and will set you 
back only $769.
| Besides the iPhone, what smart phones 
have you had success syncing with a Mac?
I have experience with Palm Desktop 4.2.1 and 
iSync working well with the Palm OS-based 
Treo 650 and syncs the addressbook, the cal-
endar and To Do Items. Their latest Treo 755p 
and somewhat older 680 and 700p should work 
as well. The Blazer Web browser can’t hold a 
candle to the iPhone’s Safari browser. There 
are some useful Palm OS applications out there, 
like FileMaker Mobile 8 for use with Palm OS 4.1 
to 5.4, DataViz’s Documents To Go Professional 
v10 (or Premium) Edition(s) to carry and view 
MS Office files and PDF files and Pocket Quicken 
for Palm OS v2.5. You should check out Mark/
Space Inc.’s The Missing Sync v6 if you want to 
sync with Apple’s software like Address Book, 
iCal, iPhoto, iTunes, and MS Entourage 2004.
| My son came home from the Cingular 
store and was told there is a bootleg copy 
of the iPhone operating system for the 
Cingular 8125 on the Internet for $60.
That is a Pocket PC smartphone running 
Windows Mobile 5 machine with a slide out key-
board. It’s screen is about half the resolution of 
the iPhone, has a 1.3 megapixel camera com-
pared to the iPhone’s 2.0 megapixels. Anyway, 
it’s more likely what is being sold, you formerly 
could have downloaded for free is, “iPhony 
v0.2,” a skin or alternate user interface for the 
initial screen. It doesn’t really change the func-
(Q&A continues on Page 3.)

here we are getting ready for a big set of LIMac 
meetings this coming Fall with a very special 
presentation in November. We are also looking 
for our members to participate in any way they 
feel they can be effective. LIMac is one of the 
best user groups out there because we care, 
work very hard, and don’t receive any compen-
sation. It is just fun!

If you would like to help, speak to me or any 
of the executive committee or board members. 
It is fun and we could use your help. See you in 
July and have a great summer. 0

(Continues on Page 3)

(June’s Meeting continues from Page 1)
www.apple.com/macpro/specs.html.

Dave went on to describe all the features 
of the new MacBooks, and MacBook Pros. All 
portables now come with one gigabyte of ram 
as the standard configuration. The MacBooks 
are ultra durable – they can stand up to lots of 
hard use. The MacBook Pros now come with a 
faster processor featuring 4 MB of level 2 cache. 
The 15-inch MacBook Pro features the new 
backlit LED display that is more energy efficient 
and provides a crisper, cleaner, and brighter 
image. It also gives you full brightness immedi-
ately after the system is turned on.

For complete specifications point your 
browser to www.apple.com/macbook/specs.html 
for the MacBook, and www.apple.com/mac-
bookpro/specs.html for the MacBook Pro.

Finally, Dave showed us the wealth of infor-
mation available in Podcasts. Through iTunes, 
you can find Podcasts on almost any topic. They 
can be audio, audio with graphics; video, and 
they can even include downloadable files. 

Lastly, Dave wowed all of us by demon-
strating how easy it is to create a Podcast using 
GarageBand, and publish it with iTunes. As 
they say, “you really had to be there for this 
part!”

Once more, we really have to thank Dave 
Marra for a really super entertaining and infor-
mative presentation. Check out Dave’s Website: 
www.marrathon.com/.
–Scott Randell

Your Kind of Erasing 
in Adobe Illustrator 
CS3:
In a previous tip, I 
discussed the new 
Eraser tool (Shift+E), 
which erases the 
parts of selected 
objects that you 
click-and-drag over. 
At the end of the tip, 
I mentioned that 
you could change 
the size and shape 
of the Eraser. If you 
double-click on the 
Eraser in the Tools 
panel, it will open the 
Eraser Tool Options 
window, which is 
nearly identical to the 
Calligraphic Brush 
Options dialog. (To 
see what I mean, look 
under the Options 
menu of the Brushes 
panel and select 
New Brush, choose 
Calligraphic, and 
click OK.) You have 
options to change 
the size of the Eraser, 
its Roundness, and 
Angle, as well as the 
ability to set a per-
centage of Variation 
for any or all of these 
settings to make 
the results look less 
computer generated. 
To use your custom 
Eraser, click OK and 
start erasing.

 TIP!

Additions to 
Swatches Panel 
Have Many Pluses 
in Adobe Illustrator 
CS3:
Once you get beyond 
the obvious advan-
tages of Live Color 
and Swatch Groups, 
you might discover 
that there are other 
great new Swatch 
features that might 
be flying under the 
radar. A favorite 
time-saving feature 
is the ability to 
select an object that 
contains an unnamed 
color and save it as 
a Swatch under the 
Options menus of 
both the Color panel 
(Add to Swatches) 
and Swatches panel 
(New Swatch).  These 
Swatches are named 
by CMYK value, which 
I always did manually 
in my illustrations. 
Best of all, you 
can select several 
objects containing 
different colors and 
save these colors 
as a Color Group by 
selecting New Color 
Group under the 
Options menu of the 
Swatches panel. In 
the dialog that opens, 
you can name the 
Group, choose to 
make all the colors 
Global Swatches, and 
also save Tints.

–Jeff Witchel

Adobe Illustrator CS3 and InDesign CS3 Tip:
Now that Creative Suite 3 has be 
released, all Tips of the Day will be 
CS3 tips from now on. For those of 

you who are still using CS2, if a tip will only  work 
in CS3, it will be mentioned it in the tip itself. If 
you have been saving old CS2 tips, most of these 
old tips will still work in CS3, but some may be 
outdated because of new features in CS3 appli-
cations that offer better ways of accomplishing 

a particular task. The first of these tips is about 
the interface, which is so totally different that 
the term “palette” has been changed to “panel.”  
Why is this an important tip? Considering the 
number of features that involve panels, knowing 
this term when you’re searching through the 
Help menu, could be the most important tip in 
learning InDesign CS3, and Illustrator CS3.

– Jeff Witchel

Adobe InDesign CS3 Tip - In CS3, 
the Laws of Transparency Have 
Been Rewritten.

In InDesign CS3, you have much better control 
of Transparency than ever before because you 
can apply Transparency to the individual parts of 
an object. So, if you want to lower the Opacity of 
just the Fill of an object, but not the Stroke, you 
can do so in the new Effects panel. One thing 
that many users of InDesign may not know is that 

some of the laws of Transparency have changed 
entirely. In InDesign CS 2, if you selected a 
Group of objects with your Selection tool (V) 
and lowered their Opacity in the Transparency 
palette, the Transparency was applied to the 
Group as a whole, not the individual objects. So, 
if you Ungrouped them (Object > Ungroup), the 
individual objects lost any Transparency that 
had been applied to the Group. Well in CS3, this 
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 TIPS!
Mac OS X 10.4.10 
improves Bluetooth, 
USB:
Apple released 
Mac OS X 10.4.10, 
addressing several 
issues in the oper-
ating system.

Among the 
changes with the 
update is a fix for 
an issue in which a 
Bluetooth headset 
may show up as an 
available device for 
sound output in the 
Sound preference 
pane after it had 
been removed from 
Bluetooth prefer-
ences.

The update also 
addresses several 
USB issues including 
improving reliability 
when using the IR 
remote control after 
waking from sleep. 
Reliability when 
mounting external 
USB hard drives has 
been improved as 
well. Users of the 
Tom Tom GO 910 
should no longer 
have a problem with 
the device being 
recognized when 
connected via USB to 
an Intel-based Mac.

Mac OS X 10.4.10 
adds RAW image 
decoding support 
for several cameras 
including the 
Panasonic DMC-LX1, 

(Q&A continues onPage 7)

Panasonic DMC-LX2, 
Leica M8, Leica 
D-LUX 2, Leica D-LUX 
3, Fuji S5 Pro, Nikon 
D40x and the Canon 
EOS 1D Mk III.

An issue where 
some DNG images 
may appear tinted 
or distorted has 
also been corrected 
and compatibility 
of Mathematica 6 
with 64-bit Macs has 
been improved.

Several other 
minor issues such as 
calendar calculations, 
importing video from 
a DV camera and 
texture corruption 
that could appear in 
Motion if the VRAM 
is full have also been 
fixed.

The update is 
available through 
the Software Update 
preference pane or 
you can download 
the Intel or PowerPC 
updates from Apple’s 
Web site.

– Jim Dalrymple

tionality of this older smartphone. (Supplanted 
by the 3G-equipped AT&T 8525 with 2Mpix 
cam by the way.) Apple legal threatened the 
sites that posted it, on the grounds of copy-
right infringement, so you probably couldn’t 
get it any more. By the way, the iPhone is a lot 
thinner, has a bigger and higher resolution 
screen, has WiFi for fast Internet access where 
available, much better Web browser, exclusive 
random access voicemail and of course cooler 
and works well with Macs. Not to mention it 
costs $600 plus the 2-year service contract.
| On my new MacBook, when I do a Get 
Info... on a document, I have duplicates of 
everything in my Open With... pop-up menu. 
How can I fix that? My other Mac is OK.
Download the free OnyX 1.8 and have it reset 
your LaunchServices database. You’ll find that 
option under Maintenance and the Reset tab. If 
you find applications won’t open their own files 
when you double-click on them in the Finder, 
you’ll want to do the same. The shareware 
Cocktail can do this as well. The applications are 
really deleting the com.apple.LaunchServices-
014XXX.csstore files (where XXX can be any or 
no number) located in /Library/Caches/ and 
then you must restart.
| I have a Epson Perfection 2400 Photo 
scanner. Can I scan in typewritten docu-
ments as text and alter it?
You should choose to dump the old scanner, get 
a Perfection V100 Photo for $60 after rebate 
which is 3200 dpi, USB 2.0 and comes with 
ABBYY FineReader Sprint Plus OCR software. 
The 2400 didn’t seem to come with any Mac 
OCR software. (just NewSoft Presto! OCR for 
Windows) If you keep the old scanner, you can 
buy the alternate scanning software VueScan 
Standard $40 by hamrick Software which 
includes SimpleOCR for Optical Character 
Recognition. You could buy professional sepa-
rate OCR programs like the I.R.I.S.’s Readiris 
Pro 11 for Mac but that costs $130 or Nuance 
OmniPage Pro X for $499.99. Back to the pur-
chase new option, if you think a step up is pos-
sible, the $181 Perfection 4490 Photo has 4800 
dpi, can scan four mounted slides or two strips 
and medium format transparencies. In between 
price-wise is the Canon CanoScan 4400F at 
$86, 4800 dpi and four slides and OmniPage 
SE. Anyway these programs recognize the let-

terforms and generate text, often with boldface 
and italics and some formatting intact. You can 
then copy and paste or save as a Word-formatted 
or .rtf -formatted file which you can open in 
AppleWorks or place into Pages, InDesign or 
QuarkXPress.
| I’ve been using a 17" MacBook Pro to edit 
video and my 160GB hard drive is almost 
filled. Is there a problem with putting my 
video stuff on that? Does that take a good 
amount of demand off the MacBook Pro? 
Should I get an external drive that uses a 
external power supply?
Yes. The lightweight mobile drives that rely on 
power from the FireWire port are lower capacity 
and lower performance. I’d suggest a full size 
drive with a FireWire 800 port for best per-
formance and it leaves your FireWire 400 port 
free for the digital camcorder. For the three-
year warranties, I’ve been suggesting Western 
Digital’s My Book Pro series which comes in 250, 
500, 750GB and 1.0 and 1.5TB sizes. Make 
sure to format whatever drive you buy, as Mac 
OS Extended (Journaled) using Apple’s Disk 
Utility. Most drives come PC-formatted and will 
show on your desktop but won’t work for these 
purposes. Just set Final Cut to use the new 
drive for the capture scratch and working direc-
tories for the “Final Cut Express Documents” 
or “Final Cut Pro Documents” folder. If you 
are using iMovie HD, then when you create a 
new iMovie project, save it on the external hD 
and iMovie stores all the clips and stills on that 
drive. Ideally, you should buy two of these 
drives – one for actually working on your video 
and another for backing it up. They have a pair 
of FW800 ports for daisy-chaining. You can 
find the My Book Pro series at the Apple Store. 
They also sell the G-Drive but those only have a 
two-year warranty and cost more for the same 
capacity. $300 vs $230 for 500GB.
| I loaded all the fonts from the “A” sub-
folder in my 2000 font type library into the 
system via Font Book, about a hundred fonts. 
Would that slow down the startup of any of 
my applications? I have Suitcase.
Yes. All your applications will take longer to 
startup. The worst may be MS office programs 
like Word. With a large font collection available 
all the time, it becomes rather a pain to scroll 

More of Bradley’s Tech Session 

Transparent Group law has been repealed. If 
you apply Transparency to a Group, and then 
Ungroup, the individual objects will still be 
Transparent.

–Jeff Witchel

Exporting Still Images
By Christopher Breen (mac911@macworld.com)
A reader seeks a solution for pulling still images 

from his QuickTime movies. He writes: “I have 
video clips in AVI format that play perfectly well 
using Quicktime Player. However, I can’t find 
instructions anywhere on how to get a snapshot 
or still photo from the video clips. Any thoughts?”
Several. If you have the $29 professional version 
of QuickTime you can simply pull up the frame 
you want to capture, choose File >Export, and, 
in the Save Exported File As dialog box that 
appears, choose Movie to BMP from the Export 

pop-up menu. Alternatively, you can choose 
Movie to Picture from this same pop-up menu, 
click the Options button, and then choose a 
different graphics format from the Compression 
Type pop-up menu in the resulting Compression 
Settings dialog box.
If you have the free version of QuickTime Player 
you can grab that still image by pressing 
Command-C to copy, opening Preview, and then 
choosing File >New From Clipboard. Save the 

file and in the resulting sheet, choose the format 
you’d like to save it in from the Format pop-up 
menu.
Finally, you can always resort to a screen shot. 
Just press Shift-Command-4 and use the selec-
tion cursor that appears to draw a marquee 
around the frame. When you let go of the mouse 
button, the selected area will be captured as a 

.png file, saved to the Desktop.
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LIMac is a proud member of the Peachpit User 
Group Partner Program and as such all LIMac 
members are entitled to a 30% discount off the 
list price of any of Peachpits books. When 
ordering at their Website (www.peachpit.com) at 
checkout, right before you enter your credit 
card number, you must enter the user group 
coupon code UE-23AA-PEUF (case-sensitive). 
This coupon code is an exclusive offer that may 
not be used in conjunction with any other 
coupon codes. Through the generosity of 
Peachpit, LIMac will also be receiving free 
books as raffle prizes. Look for them on the 
prize table when youre purchasing your raffle 
tickets at the monthly meeting.

The following vendor offers require a top- 
secret user group offer code. If you are inter-
ested in any of the following products, please 
send an e-mail to me at gwc11713@optonline.net.
Prosoft is dedicated to creating professional 
quality software designed to be easily used by 
both novice and expert users. Prosoft adopts 
the role of being data advocates, fighting to pre-
serve data and prevent data loss. Prosoft offers a 
25% discount to all MUGs using the special 
MUG discount code. Their products include: 

Drive Genius – maintain, manage and optimize 
your hard drive; Picture Rescue – digital picture 
recovery; Data Backup – backup made easy; 
Data Rescue – emergency file recovery; and 
TuneTech for iPod – maintain, manage and opti-
mize your iPod. (www.prosofteng.com)
MUG members can now take 30% off a single 
book or 35% off two or more books from 
O’Reilly, No Starch, Paraglyph, PC Publishing, 
Pragmatic Bookshelf, SitePoint, or Syngress 
books you purchase directly from O’Reilly. 
(www.oreilly.com/store)
Adam and Tonya Engst of TidBITS are con-
tinuing their sixteen years of supporting user 
groups with a special 10% discount for all orders 
in their new Take Control electronic book series. 
Take Control ebooks provide highly practical, 
tightly focused, inexpensive help from leading 
Macintosh authors. Titles are delivered in PDF 
layout with active links, and are optimized for 
viewing and printing. The user group code to 
take advantage of this generous offer is 
CPN31208MUG. (www.takecontrolbooks.com)
Do you own or work in a Mac-based small 
business that has grown out of its computerized 

Taking Control of Ruler Units with a Single 
Click in Adobe InDesign CS3:
I opened an InDesign layout that another free-
lancer had created. When I looked at my Rulers, 
they were using Picas for the units of measure-
ment. Is there any way to quickly change to 
Inches without having to go into Preferences?
Sure! Control-click with your mouse on the inter-
section of the two Rulers in the upper left-hand 

corner of your document window, and select 
Inches (or Inches Decimal) from the pop-up 
menu. To change only one Ruler, Control-click 
with your mouse on that particular Ruler.

– Jeff Witchel

Save Loads of Time with Adobe InDesign CS3 
Master Pages:
In CS2, you could Copy and Paste Master Pages 
from one document to another or even drag-

and-drop them from the Pages palette to an 
inactive document in the background. But in CS3, 
there’s an easier way to access Master Pages 
in one document for use in another. Simply look 
under the Options menu of the Pages panel for 
Load Master Pages, locate the document that 
contains the Master Pages in the dialog window, 
select it and press the Open button. It will even 
Load Masters from CS2 documents.

–Jeff Witchel

Preview as You Link in Adobe InDesign CS3:
I first saw the new loaded brush icon with its 
large preview of type as I was linking text from 
Frame to Frame. I thought, “Isn’t that cute, 
InDesign is letting me know that I’m linking 
text.” Then I took a closer look and realized that 
the brush was loaded with the beginning of the 
actual copy that I was linking. Now that’s not only  
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Helen and
Sheldon Gross
shel9@verizon.net

Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

Sore Eyes

User Group News

George Canellis
gwc11713@optonline.
net

(User Group News continues on Page 5)

(Continued from Page 3)

(Continues on Page 5)

Latest crisis. There’s always a new crisis, isn’t 
there? I found some old photographs and 
decided that they were worth a print or two. I 
looked at them with Photoshop Elements and 
they looked great. Then I tried to print them. 
Wow!

The first problem was that they were all 
red. No black, no blue, no yellow and nothing 
looked right. OK. I have a relatively new photo 
printer from hP so I looked for reasons. I 
changed the cartridges. First, I changed the 
black since all the printed text has been coming 
out pink. Then I changed the color cartridge 
as well. Well, there was improvement but not 
enough.

My next step is, as always, to e-mail Bradley 
for help. I followed his instructions care-
fully. I also wrote an e-mail to www.HP.com 
after searching their site for solutions, which 
by the way were not solutions for me. I will 
admit that their response was detailed and gave 
step-by-step instructions, but Brad’s response 

came faster and was easier to understand. I did, 
however discover a newer version of the printer 
driver and that did help.

As things stand now, there is communica-
tion between my computers and the hP Photo 
Deskjet, but!!! My pictures do not look the same 
on paper as they do on the screen. There’s the 
problem. We decided that the nozzles must be 
clogged. My old Epson had a very good built-in 
program for cleaning nozzles and restoring 
the match but hP doesn’t have that. The tools 
section is not available. hP sent another set of 
instructions today, and I will try them, but my 
complaint still stands.

how do you set the preferences to make your 
printed pictures look like those on the screen? 
Should you use Adobe settings or Apple set-
tings? how does Color Sync work with newer 
more sophisticated operating systems? And who 
can explain this in words that I can understand? 
I’m ready for a beginners course on this issue? 
Any ideas, anyone? 0

New Pages Panel 
Preview Reveals All 
in Adobe InDesign 
CS3:
I’ve always used 
the Pages palette 
in earlier versions 
of InDesign to 
quickly move around 
my document by 
double-clicking on 
pages in the palette. 
Problem was, in long 
documents, I could 
not always remember 
the page number of 
what I was looking 
for. Sometimes it 
was a real shot in the 
dark, and I would end 
up double-clicking 
on several pages 
until I landed on the 
right one. Well, this 
navigation problem 
has been solved in 
the new Pages panel 
in CS3. Every page 
in the panel has a 
preview of what is 
contained on that 
page. Very cool, and 
useful for moving 
quickly throughout a 
document with total 
confidence. But now 
it’s also easier to 
move through the 
page icons within the 
panel. If you place 
your cursor off to 
the side of the page 
icons in the panel, 
it turns into a hand 
icon, which allows 
you to click-drag up 
and down to scroll 
through the pages in 
the panel.

–Jeff Witchel

http://www.peachpit.com
mailto:gwc11713@optonline.net?subject=top-secret user group offer code request
http://www.prosofteng.com
http://www.oreilly.com/store
http://www.takecontrolbooks.com
mailto:shel9@verizon.net
http://welcome.hp.com/country/us/en/support.html?pageDisplay=support
mailto:gwc11713@optonline.net?subject=July User Group News
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(User Group News continues from Page 4)
checkbook? have you grown tired of creating 
invoices using InDesign or Word? If you think 
you are ready to move beyond your shoebox, 
MYOB has the right tool for you at a great MUG 
discount. MYOB US, Inc., the leader in Mac 
small business management, has just released 
MYOB FirstEdge, a new Mac only product that 
will help you run your business quickly and 
easily. MUG members get $25 off the regular 
price of $99 on First Edge or $100 off 
AccountEdge. (www.myob.com/us/).
Actoris Softwares Xpress Schedule is “the” 
Macintosh tool for preparing employee work 
schedules. Create better schedules in less time, 
print schedules and even send them to your  
staff by email or text message. Food Cost 
Manager is a complete back office solution for 
food service businesses. Manage your inventory, 
calculate recipe and menu costs, and prepare 
nutritional information for your customers.
(Xpress Schedule, regularly $99, is available for a 
special Apple User Group price of $74, and Food 
Cost Manager, regularly $249 is available at 
$185, that’s a 25% discount. Get the user group 
order form at www.actorissoftware.com/mug 
and then e-mail your order to sales@actorissoft-
ware.com.
CrossOver Mac allows you to run many popular 
Windows software applications on your Intel 
Mac. Your applications, documents and email 
attachments are seamlessly integrated into the 
Mac OS X. You work as you would in Windows, 
but with the freedom and ease of the Mac. You 
do it all easily and affordably, without needing a 
Windows license. CrossOver Mac offers user 
group members a special price of $47.96, a 20% 
discount off the regular price of $59.95. Special 
Code: macuser. This offer is valid through July 
31, 2007. (www.codeweavers.com/store/)
SeeFile 3.0 is a new Mac OS X application that 
lets creative pros share their work with clients, 
using their own Mac as a Webserver. SeeFile  
creates private folders for clients (each with a 
private username and password) and creates live 
thumbnails of photos, PDFs, and videos. It is 
ideal for wedding and commercial photogra-
phers, design firms, videographers and print 
providers. Specially priced at $395, user group 
members receive 20% off the list price, for the 
5-account entry version; upgrades and eCom-

merce options are available as well. Order by 
phone or e-mail with the coupon code provided.
Order by phone: 617-262-2421 Order by 
e-mail: sam@seefile.com. Coupon code: AGXE. 
This offer is valid through July 31, 2007. (www.
seefile.com).
Ovolab Geophoto is a new Mac OS X applica-
tion for browsing and collecting digital pictures 
by location. You can now browse your photo 
albums by panning, zooming and flying 
through your pictures on a three-dimensional 
representation of the Earth. Once geotagged, 
photos can be shared with other users and will 
automatically appear in the correct location on 
the Earth when opened in Geophoto. User 
group members can purchase Geophoto at the 
special price of $14.95, a 25% off the retail price 
of $19.95. Coupon code: MUG4E7h. This offer 
is valid through July 31, 2007. (www.ovolab.
com/geophoto/).
Does your iBook lose its battery life 
extremely fast? Replace it with a new larger- 
capacity and longer-lasting TruePower battery. 
Every TruePower battery comes with a one-year 
warranty and 30-day money back guarantee.  
Receive 20% off MSRP by using the following 
coupon codes on the FastMac store, or by men-
tioning the User Group when placing an order 
over the phone by calling 866-416-FAST(3278).
Battery coupon code: iBook 12": AUGB01, 
iBook 14": AUGB02. This offer is valid through 
July 31, 2007. (www.fastmac.com).
Vakaadoo is a young company that is impacting 
the accessories market with its innovative,  
creative, aesthetically pleasing and accessibly-
priced iPod cases. Their acclaimed iVak cases 
are sculptured to fit your iPod preserving and 
adding to the original beauty of its own con-
tours. The New Nano 2G is offered specifically 
to user groups for $19.95, which is a 20% dis-
count off the normal price of $24.95. To pur-
chase, go to http://www2.vakaadoo.com/
nano-2g-softfeel-discount.asp. Coupon code: 
VAK20D2G. This offer is valid through August 
31, 2007. 0
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Free Membership…
If you get three people to join, your next year’s 
membership will be free. If you get one person 
to join you will get $12 off; if you get two per-
sons, you will get $24 off. Not a bad deal! 0

 More of Mac User Groups News
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(Continued on Page 6)

(Continued from Page 4)
cool, it’s really useful, which I discovered imme-
diately. As I read the miniature version of my copy, 
I realized that I was about to link my story to the 
wrong frame.

– Jeff Witchel

Easy Mac backups
By Joe Kissell
If your computer is stolen, damaged, or inca-

pacitated, you can always repair or replace the 
hardware and software. But what about your 
data – those photos and videos of your kids, the 
big proposal that’s due on Monday, or the half-
finished epic poem you’ve been writing for years? 
Without good backups, you could lose your hard 
work and precious records forever.

The next version of Mac OS X will include the 
backup software Time Machine, but can you 
really afford to wait until then? And what if your 

backup needs go beyond what Apple’s program 
can handle? I’ll show you how to protect your 
data now. (More backup strategies and advice.)
Back up everything

If your hard drive suddenly dies, the quickest 
way to get up and running again is with a boot-
able backup (also known as a duplicate or clone). 
You store this complete exact copy of your 
startup volume on another hard drive. If disaster 
strikes, start up from that drive, and you’re back 

in business. If your entire computer is kaput, 
move the drive to another Mac.

I recommend bootable backups for almost 
everyone, but they have some downsides. First, 
they can be expensive: you’ll need a second 
hard drive that can fit all the data that’s on your 
main drive. Second, this type of backup can take 
several hours to run. Because of this, you may 
choose to update the backup less frequently, 

The non-printing 
printer:
I am still using my 
venerable Epson 880 
printer and the last 
time I put cartridges 
in, I used Office Max 
inks instead of Epson 
to save a few bucks. 
Well, I had nothing 
but trouble and now 
they’ve quickly run 
out of ink. Problem 
is, the printer still 
thinks they are half 
full. How do I go 
about changing out 
the cartridges and 
reset the levels back 
to full?

The printer thinks 
the printer cartridges 
are half full because, 
quite likely, they are. 
So why no print?

The nozzles are 
gunked up.

Although it would 
be easy enough to 
blame the non-Epson 
inks you used, it’s 
possible that the 
gunk was the result 
of not printing very 
often. I’ve owned a 
few Epson inkjets 
and have found that 
unless I print at least 
every three-to-five 
days, the print head 
gets funky. Obviously 
I haven’t owned every 

Epson inkjet made so 
your mileage could 
easily vary. (Though 
I will say that I don’t 
have this kind of 
problem on the HP 
photo printer I cur-
rently use.)

Epson recom-
mends that you per-
form a head cleaning 
and a nozzle check 
test to try to blow 
the gunk out of the 
print nozzles. Give 
this a go for up to 
three cycles. If that 
doesn’t work, Epson 
suggests that you try 
a new cartridge. If 
that’s a no go as well, 
Epson recommends 
that you take the 
printer in for service.

Because such ser-
vice can be expensive, 
I’ll suggest one other 
thing to try before 
sending it to the shop. 
Fixyourownprinter.
com offers cleaning 
kits for a wide variety 
of printers. For $10 
plus shipping and 
handling, the com-
pany will sell you a 
bottle of printer head 
cleaning solution, 
which, the company 
claims, matches 
the formula used by 
Epson.

–Christopher Breen

http://www.myob.com/us
http://www.actorissoftware.com/mug
mailto:sales@actorissoftware.com
mailto:sales@actorissoftware.com
http://www.codeweavers.com/store
mailto:sam@seefile.com
http://www.seefile.com
http://www.seefile.com
http://www.ovolab.com/geophoto
http://www.ovolab.com/geophoto
http://www.fastmac.com
http://www2.vakaadoo.com/nano-2g-softfeel-discount.asp
http://www2.vakaadoo.com/nano-2g-softfeel-discount.asp
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If you love the convenience of creating and 
printing documents from your computer, but 
miss the informal, personal touch of hand-
writing, here’s a handy idea: try a handwriting 
font.

handwriting fonts are typographic inter-
pretations of the penmanship of a real human 
being. They come in an extremely diverse range 
of styles, from the nervous, calligraphic scrawl 
of Cyberkugel to the childlike writing displayed 
by Kristen, or even a quirky, bouncy, irregular 
arrangement of caps and lowercase forms, as 
seen in Deelirious.

handwriting fonts are ideal for all those 
personal projects that most of us now do on our 
computers, including letters, personal notes, 
invitations and journals. For these documents, a 
face such as Weber Hand or Bradley Hand helps 
maintain a personal, low-tech look.

handwriting fonts aren’t only for personal 
use, though. Many professional design projects 
need the casual immediacy that a handwriting 
font can bring. These faces can be used with 
great effectiveness on book and CD covers, 
movie titles, advertising and Web graphics. 
Intimate and expressive, handwriting fonts  
add a welcome touch of individuality to any  
applcation. 0
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which increases the likelihood that you won’t 
keep current with recently updated files. But 
even with these disadvantages, bootable 
backups are fabulously useful in the event of 
major hard-disk troubles.
What You Need 

If you have a desktop Mac with space for 
a second hard drive inside, you can add a 
new internal drive to store bootable backups. 

However, I recommend an external one. It’s 
easier to move between computers if necessary, 
and you can store an external drive in a secure 
off-site location for extra insurance. 
Creating the Backup 

Because OS X relies on many files that are 
ordinarily invisible or that have special owner-
ship and permissions settings, you can’t create 
a bootable backup simply by dragging files from 
one hard disk onto another. You need special 

software to do the job for you. The best tool for 
making bootable duplicates is Shirt Pocket’s 
$28 SuperDuper. SuperDuper is fast, accurate, 
and easy to use. A solid second choice is Mike 
Bombich’s free Carbon Copy Cloner, which also 
does the job but has a trickier interface. Neither 
of these tools offers scheduled archives or 
network backups. If you want more than the 
basics, you’ll have to pony up for a full-featured 
backup program.

After Disaster Strikes 
When the time comes to start your Mac from 

the backup drive, make sure the drive is con-
nected and powered up. Turn on your Mac and 
hold down the Option key until icons of the avail-
able startup drives appear. Select the external 
drive’s icon and then press Return.

Once you’re running the system from the 
external drive, use Apple’s Disk Utility 
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Ilene Strizver
Ilene@thetypestudio.com

Ilene Strizver, 
founder of The Type 
Studio, is a typo-
graphic consultant, 
designer, writer 
and specializing 
in all aspects of 
typographic com-
munication, from the 
aesthetic to the tech-
nical. Ilene conducts 
Gourmet Typography 
Training internation-
ally. For more infor-
mation, visit www.
thetypestudio.com.

Handwriting Fonts  

LIMac’s Privacy 
Policy:
General Information 
Collection: LIMac 
acquires mailing and 
e-mail addresses 
from our members 
and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
Forum and to send 
occasional notices.
Disclosure to Third 
Parties We do not 
disclose mailing 
addresses, e-mail 
addresses or any 
other confidential 
information to third 
parties.
Questions If you 
have any questions 
concerning LIMac’s 
Privacy Policy, please 
e-mail them to about-
limac@aol.com. 0

Let ’em know you’re a LIMac member!
Our Famous LIMac logo is now available to be 
embroidered on any wearable item.

high-quality embroidery is done by ACU 
Plus Custom Embroidery, located at 3700 
hempstead Turnpike, Levittown, NY 11756; 
(516) 520-1039.
 www.acuplusembroidery.com/index.html. 0

Pay your outstanding dues now! It’s 2007!!
Send your $36 check to: Long Island Macintosh 
Users Group, Post Office Box 2048, Seaford, 
New York 11783-0180  0

(Continued from Page 5)

(Continues on Page 7)
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http://www.shirtpocket.com/SuperDuper/SuperDuperDescription.html
bradleydichter
Note
SuperDuper! 2.1.4 can do scheduled backups, and has been able to since version 2.0 came out on November 23, 2005. Carbon Copy Cloner 3, now in beta can also do scheduled clones

http://www.bombich.com/software/ccc.html


Give to LIMac by searching the Internet.
LIMac has just been registered on GoodSearch, 
as seen in Oprah magazine, ABC News, The 
New York Times, Wall Street Journal, 
USA Today, and Fortune.

There is a search engine called Goodsearch.
com that donates 50% of its revenue to charities 
and schools designated by its users. LIMac is 
now a member – and Goodsearch will donate to 
us about one cent for every search our members 
make via GoodSearch.

A penny does not sound like a lot, but the 
site is all about numbers. how much money is 
raised will depend on how well we can spread 
the word to our members – the more LIMac 
members use Goodsearch for their Internet 
searches, the more money we will raise. 200 of 
us searching four times a day will raise about 
$2,433 in a year without anyone spending a 
dime!

Think of all the money that could be raised 
while you and your friends and family are 
surfing the Web at www.goodsearch.com!

Come to the July meeting and find out more 
about GoodSearch. 0

7

later (Mac OS X 10.4 required for Image Tricks). 
Availability & Pricing: Printfolio comes in  
standard and retail editions as a download or 
boxed. The standard edition comes with lim-
ited clipart (1,000) and designs (670); $84.95 
(download). Academic pricing available. (See 
www.belightsoft.com/ buy/buy.php for more info.)

BeLight Software, www.belightsoft.com/
main.php. specializes in the production and 
distribution of Mac software and technologies. 
Their solutions cover both business and  
personal productivity. BeLight Software cus-
tomers come from more than 30 countries of 
the world. 0

(July’s Meeting continues from Page 1)

Using Spotlite:
Application names 
frequently don’t 
reflect the actual 
task that they 
perform. The name 
Safari, for instance, 
really doesn’t have 
much relation to 
web browsing after 
all. If you download 
lots of shareware 
applications, the 
situation is even 
worse, with applica-
tion names often 
being obscure or 
jokey. As an example, 
I recently found a 
great address label 
printing application, 
but now I can’t find it 
again because I can’t 
remember what the 
heck it was called 
! I know it’s in my 
Applications folder, 
but I just can’t seem 
to find it.

Well, there’s an 
easy way to keep 
track of what task 
applications perform. 
Use Get Info in the 
Finder on the appli-
cation in question, 
and in the Spotlight 
comments section, 
type a few descriptive 
words about what 
that application 
does. In the example 
above, I’d probably 
type address labels.

Now, next time 
you want to find an 
application that 
does a specific task, 
just use Spotlight 
to search for the 
keywords associated 
with that task. The 
applications that 
match will be found 
and displayed in the 
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(/Applications/Utilities) or a third-party utility 
to try to repair your main drive. Assuming your 
internal drive isn’t physically damaged, you 
can duplicate your external drive back onto the 
internal drive to restore it to a bootable state. 
Back up the essentials

Regardless of whether you create bootable 
backups, be sure to make copies of your impor-
tant and frequently used files. The easiest and 

safest way to do this is to back up your entire 
user folder, which should contain most of the 
files you work with regularly. If this folder is very 
large, backing up the entire thing can take time 
and require a lot of storage space. At a minimum, 
back up your irreplaceable files 
What You Need 

You can back up your files on almost any 
medium, from recordable CDs and DVDs to 
network volumes. However, for ease and speed, I 

recommend an external hard drive. Hard drives 
provide the fastest possible backups, they don’t 
require that you manually swap and label optical 
discs, and they can typically hold several months’ 
worth of archived files.
Creating the Backup

 It’s best to back up all your important files 
and folders once a day. You can do this manu-
ally, but a backup tool will automate the entire 
process.

Each backup program has its own procedure 
for setting the source, destination, schedule, 
and other backup options. As with bootable 
backups, if a file is accidentally deleted, modi-
fied, or damaged, and you don’t notice until after 
the backup runs, you’re out of luck. To avoid 
these problems, make sure that your backup 
program creates archives – in other words, that 
it saves old copies of files when adding new ones. 

(Continues on Page 8)

(Q&A continues from Page 3)
through the long list when you need Verdana. I 
would suggest you use Suitcase Fusion to hold 
the fonts at the ready and easily activate and de-
activate fonts or sets of fonts as needed. Suitcase 
Fusion can automatically turn on an Application 
Set of fonts when you start up a specific program 
where you need a greater selection. For Adobe 
InDesign, Illustrator and QuarkXPress, there are 
plug-ins for Suitcase that can auto-activate indi-
vidual font suitcases as needed by a document. 
For those of you without Suitcase, you can try 
the free Linotype FontExplorer X. It doesn’t sup-
port Quark 7 and Adobe CS3, but you get what 
you pay for.
| I have an iBook G3 running Mac OS 10.2 
and I downloaded and installed the 10.2.8 
update. After the reboot, I just get the spin-
ning gear. So I trashed that and reinstalled 
the whole thing.
Sounds like you have something incompatible 
with 10.2.8 installed or perhaps some hardware 
conflicting. Maybe a old Stuffit Deluxe which 
worked with 10.2 but not 10.2.8. You should 

never do a system update with none essential 
hardware connected, like FireWire and USB 
devices or external monitors. I would try one 
more install of 10.2 without preserving settings 
from before. Then download and install the 
combo update to 10.2.8 and that should work. 
Then you can let System Update do the rest of 
the lesser updates. Run Disk Utility and repair 
permissions and then download any newer 
installers you can to replace any 3rd party soft-
ware that you had.
| I just bought a T-Mobile BlackBerry. Is it 
compatible with the Mac OS X?
Not really – no. Not by itself from Research 
in Motion. BlackBerry Desktop Software is 
Windows only. You could add the Missing Sync 
for BlackBerry from Mark/Space, Inc. or try the 
free PocketMac for BlackBerry from Information 
Appliance Associates.
| I downloaded and installed Adobe Reader 
7.0.8, got the notice there was a update and 
installed it, but the icon in the dock still 
shows 7.0.8. Why?
The Adobe Updater didn’t bother changing 
the application’s name, nor the name of the 
enclosing folder. If you opened the About... box, 
you’d see it is in fact 7.0.9. Call it a bug if you 
will. It only takes a few seconds to fix the names 
yourself. By the way, if you are running Mac OS 
10.4.4 or newer on Intel or 10.4.3 or newer on 
PowerPC-based Macs, you can download ver-
sion 8.1 of Adobe Reader. Mo Lebowitz says the 
Forum looks “OK” in this newest generation 
Acrobat Reader. 0

(Continues from Page 6)

Custom Control of 
the Control Panel 
in Adobe Illustrator 
CS3:
With all the new 
features in Illustrator 
CS3, there are more 
commands than 
ever in the Control 
panel. Because 
it’s contextual, the 
commands avail-
able in the Control 
panel may be totally 
different depending 
on what object is 
selected, and what 
tool is being used. If 
you’re finding the 
large number of 
commands available 
slightly overwhelming, 
you can totally cus-
tomize the panel to 
best meet your needs. 
To do so, look under 
the Options menu of 
the panel and simply 
uncheck all com-
mands that you don’t 
want to be available. 
You can also alter the 
panel’s commands to 
work best on certain 
kinds of projects. 
For instance, if 
you’re working on an 
illustration for print 
media that will not 
involve type format-
ting or Flash-related 
features, you could 
turn off those fea-
tures in the options 
menu and then save 
your panel options 
as part of a Custom 
Workspace (Help > 
Workspace > New) 
for your illustration 
projects.

—Jeff Witchel

(Continues on Page 8)

http://www.goodsearch.com
http://www.belightsoft.com/buy/buy.php
http://www.belightsoft.com/main.php
http://www.extensis.com/en/products/font_management/product_information.jsp?id=1060
http://www.linotype.com/fontexplorerX
http://www.pocketmac.net/products/pmblackberry/
http://www.markspace.com/missingsync_blackberry.php
http://www.markspace.com/missingsync_blackberry.php
http://www.adobe.com/products/acrobat/readstep2.html
bradleydichter
Correction
The search engine in Mac OS 10.4 and the forthcoming 10.5 is called Spotlight. See http://www.apple.com/macosx/features/spotlight/

http://www.goodsearch.com/Default.aspx
http://www.belightsoft.com/main.php
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Applications section 
of the results list. For 
instance, when I want 
to print an address 
label, I just open the 
spotlight search and 
type address labels, 
and there’s the list 
of matching applica-
tions

✔ This hint 
discussed using 
Spotlight comments 
to launch applica-
tions more quickly, 
which is similar in 
concept to this hint. 
However, using the 
comments as a 
means of identifying 
what an applica-
tion does is a good 
idea. If you use a 
unique prefix, maybe 
something like wdtd 
(what does this do) 
in the comments 
box, your Spotlight 
searches will return 
only your matching 
applications, as the 
odds of finding wdtd 
in any other file are 
quite low.

ThE LIMAC ON-LINE FORUM/JULY 2007

DAN DANGLO

“How tHe Heck would I kNow tARZAN’s e-MAIl AddRess?”

How to better visually 
enjoy the Forum: 
Your Editor prefers you to  
use Preview (with OS X) or 
PostView (www.metaobject.
com/Products.html#PostView)
or Adobe Acrobat Reader 8.1 

for reading the Forum.pdf – excellent programs 
that handle.pdf files with visual accuracy. (Also 
read their Help files to discover the many tools 
and techniques they have available.) 

You’ll be happily surprised! 0

EXCELLENT!!

8

George Cohen won this month’s 

door prize. We thank Designscapes

for donating the iPod for George. 0

(Continues from Page 7)
That’s standard practice with EMC Insignia’s 
$96 Retrospect Desktop and Apple’s Backup 
(included with a $100 .Mac membership). With 
Prosoft Engineering’s $59 Data Backup, use 
the Versioned Backup feature. With Tri-Edre’s 
$49 Tri-Backup, use the Evolutive Mirror Backup 
feature.
After Disaster Strikes

 The problem you’re likeliest to encounter is 
the discovery that you’ve unintentionally deleted 
or modified an important file. Most backup soft-
ware lists all your backups by date, so you can 
choose to restore specific versions of individual 
files (or in some cases, all your backed-up files). 
I recommend restoring the file to a new location. 
That way, you can compare the two versions of 
the file and avoid accidentally overwriting a ver-

sion containing newer data you still need.
If you lose your entire disk’s contents, your 

first step is to repair the disk (or replace the 
drive), reinstall OS X and your backup applica-
tion, and then restore the most recent versions of 
all your backed-up files. In this case, since you’re 
restoring everything, put the files back in their

 original locations.
The last word

Without backups, you’re computing on bor-
rowed time. But an effective backup strategy 
need not be time-consuming or costly. The most 
important thing is to pick a plan and put it into 
practice today. 0

(Spotlite from Page 7)

http://www.metaobject.com/Products.html#PostView
http://www.metaobject.com/Products.html#PostView
http://www.emcinsignia.com/products/smb/retroformac/
http://help.apple.com/mac2/1/help/bckup/pgs2/bck_fmset01.html
http://www.prosofteng.com/products/data_backup_info.php?PHPSESSID=4764097fb35afd8958b75fb2e2f89985
http://www.tri-edre.com/english/index.html

